Development Tools
for ARM-Powered Devices

MDK-ARM Microcontroller Development Kit
ULINK USB-JTAG Adapters
Evaluation Boards
**Agenda**

- Introduction and Overview
- Keil MDK-ARM Microcontroller Development Kit
  - \(\mu\)Vision4 Integrated Development Environment
  - ARM Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace
- Hardware Components
  - ULINK USB-JTAG Adapters
  - Evaluation Boards
- RTX Real-Time Kernel
Agenda

- Introduction and Overview
  - Keil MDK-ARM Microcontroller Development Kit
    - µVision4 Integrated Development Environment
    - ARM Compilation Tools
    - Verification and Debug
      - Complete device simulation
      - Analysis tools
      - CoreSight Debug & Trace
  - Hardware Components
    - ULINK USB-JTAG Adapters
    - Evaluation Boards
  - RTX Real-Time Kernel
Keil Microcontroller Tools

- Leading supplier of MCU development tools
  - ANSI C/C++ compilers, Debuggers
  - Device simulation
  - Middleware components

- Extensive Device Database®
  - >1,600 8/16/32 bit MCUs

- Established support
  - Web support portal
  - User group structure
  - Global distribution network

- Huge installed base
  - 100K+ users world wide
Tools for ARM-Powered Devices

Microcontroller Development Kit

Complete software development environment for Cortex-Mx and ARM7/9 microcontrollers
Easy to learn and use, yet powerful enough for the most demanding embedded ARM applications

ULINK USB Adapters
On-the-fly debugging and Flash programming via JTAG or serial interface

MDK-ARM
Microcontroller Development Kit
- ARM C/C++ Compiler
- RTX RTOS Kernel Library
- μVision Device Database & IDE
- μVision Debugger & Analysis Tools
- Complete Device Simulation

RTX and Real-Time Library
Fully featured real-time kernel
Library of middleware components to speed up software development and solve real-time and communication challenges

RL-ARM
Real-Time Library
- RTX RTOS Source Code
- TCPnet Networking Suite
- Flash File System
- USB Device Interface
- CAN Interface
MDK-ARM Microcontroller Development Kit

Complete software development environment for ARM processor-based microcontrollers. Easy to learn and easy to use!

- **Industry leading technology**
  - ARM RealView Compiler
  - Keil µVision IDE / Debugger

- **Complete device support**
  - ARM7, ARM9, Cortex-Mx MCUs
  - Includes Start-up code & Flash algorithms
  - Complete device simulation
  - Board support packages (BSPs)

- **RTX Real-Time Kernel**
  - Efficient RTOS Kernel for small systems
RL-ARM Real-Time Library

- Meets Embedded Developers’ needs
  - Solves common embedded challenges
    - Real-Time Systems
    - Embedded communication & networking
  - Designed for use with MCU Devices
- Extensive Range of Examples
  - Easy to begin working
  - Can be used as building blocks
- Royalty Free
  - Includes RTX source code.
  - License – single user, multi project

Extensive library of common ready-to-use middleware components, speed software development.

RL-ARM Real-Time Library

- RTX Source Code
- TCP/IP Suite
- Flash File System
- USB Device Interface
- CAN Interface

Examples and Templates
Hardware Components

Range of evaluation boards and debug hardware.

- **ULINK family of USB–JTAG Adapters**
  - Debug and Flash programming
  - JTAG and SWD support

- **Evaluation Boards**
  - ARM7, ARM9 & Cortex-M3
  - Luminary, NXP, ST & Toshiba
Agenda

- Introduction and Overview
- **Keil MDK-ARM Microcontroller Development Kit**
  - μVision4 Integrated Development Environment
  - ARM Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace
- Hardware Components
  - ULINK USB-JTAG Adapters
  - Evaluation Boards
- RTX Real-Time Kernel
Today’s Microcontroller Selection

- Wide range of MCU cores
  - 8/16/32 bits
  - On-chip memory
  - Interrupt system

- Peripherals
  - I/O Pins, Timers, PWM
  - A/D and D/A Converters
  - UART, SPI, I2C
  - Complex communication peripherals (CAN, USB, Ethernet)

Customers expect support for specific Microcontrollers.

Block Diagram of Cortex-M3 MCU
Keil MDK-ARM supports MCUs

- Out of the box support
  - >490 ARM MCUs
  - Start-up code and configuration wizards
  - Flash Algorithms and debug information
  - Examples and Templates
    - Including BSPs for common boards
- Complete device simulation
  - Not only a processor simulator!
  - Includes On-Chip peripherals
    - A/D, D/A, EBI, Timers
    - UART, CAN, I2C, Interrupts, etc.
    - External signals and I/O

Instantly begin developing software. No need for hardware or in-depth knowledge of target MCU.
Integration with the ARM Compiler

μVision IDE is common to all Keil based tools. MDK-ARM uses the ARM RealView Compiler.

- **Keil μVision IDE**
  - Common to all Keil based tools
    - Cx51, C166 and ARM
    - More than 100,000 users
  - Powerful, easy to use, standard device focused

- **ARM Compiler**
  - Replaces Keil CARM compiler for ARM-powered MCUs
    - C51 and C166 will continue to be developed
  - Industry leading compiler – best performance and code size
Agenda

- Introduction and Overview
- **Keil MDK-ARM Microcontroller Development Kit**
  - µVision4 Integrated Development Environment
  - RealView Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace
- **Hardware Components**
  - ULINK USB-JTAG Adapters
  - Evaluation Boards
- **RTX Real-Time Kernel**
μVision IDE

μVision is the industry leading Integrated Development Environment (IDE) for microcontroller and smartcard devices.

- Common to ARM, C166, and 8051 platforms
  - Includes target device configuration and Device Database
  - High speed simulation
    - Instruction Set
    - On-chip peripherals
  - Source code editor
  - Project debugging
  - Flash programming
μVision4 – Multi-Monitor Support

- Flexible windows management
  - Support for multiple monitors
  - Drag and drop windows anywhere on the work space
- Docking windows
  - Leave windows floating or docked to others
μVision4 – Flexible Windows Management

- Multiple windows
  - Open multiple versions of windows
  - Can be docked together or floated in workspace

- Tabbed groups
  - Group related windows together
  - Easy access and navigation
μVision4 – System Viewer Windows

- Provide information about device peripheral register contents
  - Detailed status information is available
  - Change register values directly from the window
- Flexible views
  - Window can show registers from one or multiple peripherals
  - Can open multiple windows during a debug session
μVision4 – Debug Restore views

- Save multiple debug window layouts
  - Customize view to suit application being debugged
  - Save multiple views for a project
  - Save a view globally or locally
µVision4 – Multi project workspace

- Often need to work on more than one project at same time
  - Develop application and bootloader

- Multi-project workspace
  - Define a group of projects as a Multi-Project Workspace file (.MPW)
  - Work on them in one project workspace
Device Database

- **On-line**
  - Includes Parametric Search
  - www.keil.com/dd

- **µVision**
  - Includes main parameters for device
  - Enables easy project creation
  - Fast device configuration

Device Configuration

- Available for all devices
  - Included in Device Database
  - User configurable (text or wizard)

- Configuration Wizard
  - Main parameters for device
  - Drop-down selection or user entry
  - Enables stable device start-up

Configuration wizards enable effortless device set-up.
Examples and Templates

- **Board Support Packages**
  - Examples and BSPs provided for a high number of popular evaluation boards from many vendors
  - Examples work on target hardware or simulation

- **Templates**
  - Enable base for user projects
Source Browser

Displays variable and function definitions and where they are used throughout your application.

- **F12**
  - Displays variable definition
- **Source Browser View**
  - Displays all locations of variables or functions
Agenda

- Introduction and Overview

- Keil MDK-ARM Microcontroller Development Kit
  - μVision4 Integrated Development Environment
  - ARM Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace

- Hardware Components
  - ULINK USB-JTAG Adapters
  - Evaluation Boards

- RTX Real-Time Kernel
ARM Compilation Tools

Best in class compilation tools, enabling applications to run faster while reducing system cost.

- The ARM Compilation tools contain:
  - Highly-optimizing ISO C/C++ compiler
  - Supports ARM, Thumb and Thumb2 Instruction sets including FPU
  - Full C and C++ run-time library support

- The ARM Compiler Advantage
  - Smaller, Faster Code

- ARM Compiler v4.0
  - Micro Library for small Embedded Systems
  - Source Browser Integration for µVision
MicroLib – Optimized C Libraries

- Superset of standard ARM C Library
  - Developed for embedded and memory constrained applications
  - Optimized for embedded applications
    - Minimal overhead for un-used OS functionality
    - Un-used functions removed from memory footprint
  - Faster system bring-up
    - Most functions initialized at point of use
- Up to 92% Reduction in Library Code size
  - ‘empty main’
  - Even more for ‘Hello World’ using Print f

MicroLib significantly reduces library size in embedded applications.
RealView MDK libraries reduce system code size by 50% to 90%.

### Library Totals

<table>
<thead>
<tr>
<th>Processor</th>
<th>Object</th>
<th>Standard</th>
<th>MicroLib</th>
<th>% saving</th>
</tr>
</thead>
<tbody>
<tr>
<td>ARM7TDMI</td>
<td>ARM</td>
<td>21,352</td>
<td>8,980</td>
<td>61%</td>
</tr>
<tr>
<td></td>
<td>RO Total</td>
<td>25,608</td>
<td>12,816</td>
<td>51%</td>
</tr>
<tr>
<td>ARM7TDMI</td>
<td>Thumb</td>
<td>17,156</td>
<td>6,244</td>
<td>57%</td>
</tr>
<tr>
<td></td>
<td>RO Total</td>
<td>20,129</td>
<td>9,348</td>
<td>50%</td>
</tr>
<tr>
<td>Cortex-M1</td>
<td>Thumb</td>
<td>16,452</td>
<td>5,996</td>
<td>64%</td>
</tr>
<tr>
<td></td>
<td>RO Total</td>
<td>19,472</td>
<td>9,016</td>
<td>54%</td>
</tr>
<tr>
<td>Cortex-M3</td>
<td>Thumb-2</td>
<td>15,018</td>
<td>5,796</td>
<td>63%</td>
</tr>
<tr>
<td></td>
<td>RO Total</td>
<td>18,616</td>
<td>8,976</td>
<td>54%</td>
</tr>
</tbody>
</table>

Based on Dhrystone 2.1 Benchmark
Agenda

- Introduction and Overview
- Keil MDK-ARM Microcontroller Development Kit
  - µVision4 Integrated Development Environment
  - ARM Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace
- Hardware Components
  - ULINK USB-JTAG Adapters
  - Evaluation Boards
- RTX Real-Time Kernel
µVision Device Simulation

All components of the Target Device are Simulated. Code can be run on entire device.

- Complete simulation of target
  - Fast Instruction Set Simulation (ISS)
  - On-chip peripherals
    - ADC, DAC, EBI, Timers
    - UART, CAN, I2C, Interrupts, etc.
  - Includes external signals and I/O

- Dialog Boxes
  - Complete access to peripherals
    - Read and write

www.keil.com/uVision/db_sim.asp
The µVision Advantage

Complete Device Simulation allows software testing with no hardware, providing quick test cycles and improving product quality.

- Advantages of Complete Device Simulation
  - Test before hardware available
  - Hardware cannot be damaged
  - No extra components required

- Real advantages vs. hardware
  - Embedded Trace has limitations
  - Many things are only possible in simulation
  - Lower cost

- Easy with MDK-ARM
  - All included in Device Database
  - Removes configuration hassles
ETM Style Trace

ETM Trace is not available in all systems.

- ETM is relatively new to MCU world
  - Increasing with ARM9 MCU families
  - Very rare in ARM7 MCU devices
- ETM not always available
  - Requires additional pins
  - ETM pins shared with other I/O
    - E.g. ADC or GPIO
- Additional Hardware
  - Costly

**Complete Device Simulation** offers all the advantages of ETM without the disadvantages
CPU and Peripheral Control

Simulation offers true system synchronization with all components that allows total system halt, detailed analysis, and full run control.

- **Halt Stops Peripherals**
  - Whole system stops
  - Breakpoint and Single-Stepping
  - External signals all stop

- **Complete System Analysis**
  - Test can be reproduced
  - Executes from a ‘known’ state

- **Full Power-Down Control**
  - Debug in all MCU states
  - System is always accessible
  - Timing analysis of power-down activity

- **No Adaptation Hassle**
  - Hardware can be destroyed
  - Small systems are physically hard to connect
Agenda

- Introduction and Overview
  - Keil MDK-ARM Microcontroller Development Kit
    - µVision4 Integrated Development Environment
    - RealView Compilation Tools
    - Verification and Debug
      - Complete device simulation
      - Analysis tools
      - CoreSight Debug & Trace
  - Hardware Components
    - ULINK USB-JTAG Adapters
    - Evaluation Boards
  - RTX Real-Time Kernel
μVision Code Coverage

Simulation gives extra features not available with JTAG Debuggers. For example: Code Coverage at Source and Assembly Level.

- Execution Statistics
  - Always Active for Complete Project
  - Instruction Status
  - Color Coded
  - Multi-Session Coverage
  - With Save / Restore
μVision Execution Profiling

Simulation provides exact CPU Timing and allows detailed program execution analysis with different parameters.

- Detailed Timing Statistics
  - Active for Complete Project
  - Execution Time
  - Number of Executions
- Flexible Views
  - Source
  - Disassembler
  - Complete Overview
μVision Logic Analyzer

Allows analog and digital signals to be monitored graphically. Easy, fast analysis of signal timing with code trace.

- Timing Analysis
  - Analog & Digital I/O Pins and Signals
  - Internal Variables
- Exact Timing
  - Using Cursor Line
  - Tool-Tip Delta Information
- Direct Code Analysis
  - From Analyzer Window
Kernel Aware Debugging

RTX and µVision are tightly integrated, kernel aware debugging is fully supported.

- Tasks and Event analysis
- Resource Loading
  - Allowing resource optimisation
Agenda

- Introduction and Overview
  - Keil MDK-ARM Microcontroller Development Kit
    - \(\mu\)Vision4 Integrated Development Environment
    - RealView Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace
- Hardware Components
  - ULINK USB-JTAG Adapters
  - Evaluation Boards
- RTX Real-Time Kernel
New debug and trace technology in Cortex-Mx devices, enhances EmbeddedICE technology of ARM7 and ARM9 devices.

- **Serial Wire Debug (SWD)**
  - 2-wire interface for debug
  - Offers extra functionality over JTAG, using less I/O

- **Serial Wire Viewer (SWV) – 1 extra pin**
  - Using 1 extra pin
  - Offers Real-Time Trace with no extra hardware
  - Cortex-M3 only

- **SWD and SWV are included on the standard JTAG connector**
  - No need for new connectors or debug hardware adapters

- **Supported in MDK with ULINK Adapters**
Real-Time Trace (SWV)

No additional software or hardware is required. Just MDK + ULINK2 (or ULINK-ME)……..and a PC with USB.
μVision provides 3 different ways in which to view variables.

**Memory Window** – View > Memory Window

**Watch Window** – View > Watch and Call Stack Window

**ITM Viewer** – View > Serial Window > ITM Viewer
Trace Windows

Different types of Trace Data can be viewed in µVision’s three Trace Windows and the Logic Analyzer.

- **Easy configuration**
  - Cortex-M Target Driver Setup window

- **Four Trace Views:**
  - Trace Records
  - Logic Analyzer
  - Exceptions
  - Counters
Trace Records capture:

- Timestamp, PC sample, Read/Write PC selectable
- Filter window to remove certain lines
- Can be changed while CPU is running
- Time delay and lost cycles are noted

Automatically displays variables which have been selected to capture trace data.
Trace Windows - Exception Trace

Displays statistical information about program exceptions.

- Displays:
  - Exception name & number, number of times entered
  - Max and Min time spent in and out of exceptions
  - First and Last time entered

![Exception Trace Table]

<table>
<thead>
<tr>
<th>Num</th>
<th>Name</th>
<th>Count</th>
<th>Total Time</th>
<th>Min Time In</th>
<th>Max Time In</th>
<th>Min Time Out</th>
<th>Max Time Out</th>
<th>First Time [s]</th>
<th>Last Time [s]</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>NMI</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0.00021660</td>
<td>25.44279225</td>
</tr>
<tr>
<td>3</td>
<td>HardFault</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>MemManage</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>BusFault</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>UsageFault</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>SVCAll</td>
<td>475</td>
<td>158.236 ms</td>
<td>77.500 us</td>
<td>80.736 us</td>
<td>135.861 us</td>
<td>14.549 s</td>
<td>0.00021660</td>
<td>25.44279225</td>
</tr>
<tr>
<td>12</td>
<td>DbgMon</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>PendSV</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>SysTick</td>
<td>2576</td>
<td>4.309 ms</td>
<td>1.417 us</td>
<td>93.694 us</td>
<td>765.222 us</td>
<td>10.066 ms</td>
<td>0.00087276</td>
<td>25.47015878</td>
</tr>
<tr>
<td>16</td>
<td>ExtIRQ 0</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>ExtIRQ 1</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>ExtIRQ 2</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>ExtIRQ 3</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>ExtIRQ 4</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>ExtIRQ 5</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>ExtIRQ 6</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>ExtIRQ 7</td>
<td>0</td>
<td>0 s</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Trace Windows - Event Counters

- Event Counters
  - Shows the number of times counter ‘rolls over’, updated in real time
  - Can be cleared by clicking on the “0”

![Event Counters](image-url)
Agenda

- Introduction and Overview
- Keil MDK-ARM Microcontroller Development Kit
  - μVision4 Integrated Development Environment
  - RealView Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace
- Hardware Components
  - ULINK USB-JTAG Adapters
  - Evaluation Boards
- RTX Real-Time Kernel
New Features

- Cortex-M3 Serial Wire Debug and Trace
- Plug and Play USB Installation
- On-the-fly debugging with Real-Time Agent

Program Debugging

- Single Stepping & Real-Time Execution
- Flash and Software Breakpoints
- Memory Access Breakpoints

Flash Programming

- Download, Verify, and Execute

Easy to use USB run control adapter, supporting JTAG debug and Flash programming.
ULINKME – Low Cost Adapter

Low cost design for evaluation and starter kits, with same functionality as ULINK2.

- **Features**
  - Cortex-M3 Serial Wire Debug and Trace
  - Plug and Play USB Installation
  - On-the-fly debugging with Real-Time Agent
  - Target power via ULINK-ME
  - Mini USB connector
  - Small and low cost
  - ARM 20-pin (0.1”) only
  - 28 x 80mm (1 ¼” x 3 ¼”)
ULINKPro Adapter

- New debug and trace unit
- Run control debug for ARM and Cortex-M3 processor
- Tracing of Cortex-M3 processor
  - ETM instruction trace records instruction by instruction program execution
  - Data trace via Serial Wire Viewer

<table>
<thead>
<tr>
<th>Features</th>
<th>ULINK2</th>
<th>ULINKPro</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run control debug (ARM &amp; Cortex-Mx)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Run control debug (8051 &amp; C166)</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Data Trace (Cortex-M3)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Instruction Trace (Cortex-M3)</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Performance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JTAG Clock speed</td>
<td>10MHz</td>
<td>50MHz</td>
</tr>
<tr>
<td>Flash Download</td>
<td>28KByte/s</td>
<td>600KByte/s</td>
</tr>
<tr>
<td>Data Trace streaming</td>
<td>500Kbit/s</td>
<td>100Mbit/s</td>
</tr>
</tbody>
</table>

- Available – Sept 2009
Wide Range of Evaluation Boards

- Designed for easy set-up
  - Extensive program examples
  - Wide range of peripherals
  - Popular ARM based MCUs

Proven hardware for quick project development and debug.

STM32E

Toshiba TMPM330

LPC1700
Agenda

- Introduction and Overview
- Keil MDK-ARM Microcontroller Development Kit
  - μVision4 Integrated Development Environment
  - RealView Compilation Tools
  - Verification and Debug
    - Complete device simulation
    - Analysis tools
    - CoreSight Debug & Trace
- Hardware Components
  - ULINK USB-JTAG Adapters
  - Evaluation Boards
- RTX Real-Time Kernel
RTX Real-Time Kernel

Full-featured Real-Time kernel designed to meet the challenges of Embedded System Design.

- **Process Management**
  - Create and delete tasks
  - Change task priorities
  - Event flag management
  - Interrupt functions
  - CPU resources

- **Multi-Tasking**
  - Pre-emptive context switching
  - Scheduling
  - Semaphore management

- **Real-Time Control**
  - Deterministic behaviour

- **Inter-task Communication**
  - Mailbox management
  - Interface to interrupt functions

- **Memory Allocation**
  - Thread-safe (usage even in ISR)
RTX Features

Full-featured Real-Time kernel meets the requirements of a ‘good’ real-time kernel.

Main Features

- Multi-Tasking – Round Robin, Pre-emptive, Cooperative
- Unlimited – User Timers, Semaphores and Mailboxes
- Royalty free

<table>
<thead>
<tr>
<th>Task Specifications</th>
<th>Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Task Priority Levels</td>
<td>1 - 254</td>
</tr>
<tr>
<td>No. of Tasks Defined</td>
<td>Unlimited</td>
</tr>
<tr>
<td>No. of Tasks Active</td>
<td>254</td>
</tr>
<tr>
<td>Context Switch</td>
<td>&lt; 300 Cycles</td>
</tr>
<tr>
<td>Interrupt Latency</td>
<td>&lt; 100 Cycles</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Memory Requirements</th>
<th>Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODE Space (depending on used functionality)</td>
<td>1.5K – 5K</td>
</tr>
<tr>
<td>RAM Space (each active task requires own stack space)</td>
<td>&lt; 500</td>
</tr>
</tbody>
</table>
**RTX Support for Cortex-Mx Processors**

MDK-ARM includes a new implementation of RTX optimized for Cortex™-M1 and Cortex-M3 processors.

- **RTX (M)**
  - A different implementation for Cortex-Mx devices
    - Have extended RTOS features, allowing more robust and fail-proof RTX Kernel implementation
    - ARM7™/ARM9™ version uses `os_clock_demon` system clock task to control task switches of all user tasks.
    - Cortex™-M version does not have `os_clock_demon` task. It does not exist in this version. All system calls are executed as **SVC** System Supervisor Calls.
  - Higher performance compared to ARM7TDMI
    - [http://www.keil.com/support/man/docs/rlarm/rlarm_ar_timing_spec.htm](http://www.keil.com/support/man/docs/rlarm/rlarm_ar_timing_spec.htm)
Tool Chain Integration

RTX is fully integrated into RealView MDK for easy development and debugging.

- **Compilation**
  - Tasks are integrated into the RealView C Compiler language
  - Close integration in RealView MDK (μVision)

```c
void task1 (void) _task {
    ... code of task 1 placed here....
}
```

- μVision IDE automatically includes RTX Libraries
Customers use www.keil.com on a daily basis to obtain program examples, latest technical information, and support.